
LexisNexis® CaseMap Quick Start Tutorial 

 

Introduction 

CaseMap is a case organization, analysis, and reporting tool.  So we've divided this tutorial into 
three lessons:  Organize, Analyze, and Report. This tutorial will take you through the basics of using 
CaseMap to work your cases. 
 

Why CaseMap? 

1) CaseMap provides a framework and a method for organizing and evaluating the facts in any 
case. 

 
2) You’ll gain a thorough understanding of the dispute and clarify your thinking about it. As you 
sort out what you do know about the case, you’ll find it easy to identify what you don't know and 
what you need to find out. 

 
3) CaseMap clearly draws a distinction between facts and documents.  Actions concerning a 
document can be facts (Hawkins wrote an email to Lang.)  However, a frequent scenario is that 
a particular document contains numerous facts.  Bottom line: facts and documents live in 
different places in CaseMap. 

 
4) CaseMap files can be used by multiple members of a case team at the same time. Create a 
single file which you store in a shared location on your network. 

 
5) Your entire team will be able to work together to organize critical knowledge about the facts, 
the cast of characters, and the issues in your cases. 

 
6) Case organization, analysis, and reporting tasks can be delegated and distributed to divide 
and conquer the task of bringing order out of chaos in any matter. 

 
7) Investing the time to organize and share case knowledge in CaseMap pays big dividends 
when it's time to analyze, strategize, file motions or briefs, negotiate a settlement, or take the 
case to trial.  Even if you haven't picked up the case file for months CaseMap keeps case 
knowledge, documents and your thinking about the case at your fingertips. 

 
8) CaseMap helps you ensure complete discovery, no matter what type of case you handle -- 
civil or criminal. 
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Recommended Learning and Support Resources 

 
Please take advantage of our free 60-minute CaseMap Fundamentals phone orientation.  We even 
make the call for your session.  Book an appointment by calling 877-301-0344 or by emailing 
casemap.support@lexisnexis.com. 
 
Learn about beginning, intermediate, and advanced CaseMap topics in the Webinar Center, 
available 24/7 at no charge.  Many of the online tutorials are ~10 minutes long--start, stop, fast-
forward, rewind--go at your own pace.  Click here to visit the LexisNexis CaseMap Webinar Center. 
 
CaseMap's Help system--click the Help menu at the top of your CaseMap screen.  Then click 
Contents… to view the Help system. 
 

 
 

Click Training Options on the Help menu for training class information. 

Please contact us if you have any questions about using CaseMap:  call 877-301-0344 or email 
casemap.support@lexisnexis.com.  Hours for live support are 9:00 AM to 6:00 PM, Eastern U.S. 
time, Monday-Friday. 
 

 

 

 

 

 

 

 

mailto:casemap.support@lexisnexis.com
http://www.casemap.com/webinar/webinars.asp
mailto:casemap.support@lexisnexis.com
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Four Basic Terms 

Spreadsheet:  The different working areas of a CaseMap file that you see.  Access 
spreadsheets using the shortcut buttons available on the Navigation Pane on the left side of the 
screen.  A spreadsheet view = a report. 
 
Field:  The columns that appear in a spreadsheet view are also known as fields. For example, 
the Date & Time field stores the date and time when each case fact occurred. A record is made 
up of fields. 
 
Record:  The information in the case file that describes a particular fact, object, issue, question, 
or research item makes up a record. Records appear in a spreadsheet view as rows running left 
to right. 
 
Cell: A cell is the place where you type data--where a field and a record intersect. 
 

A Few More Important Terms 

Link: A connection between two case elements, e.g., a connection between a fact and the 
issues on which that fact bears. 
 
Search: A way to explore your case information. CaseMap offers two primary search methods: 
filtering and tagging. Filtering limits the rows in your spreadsheet to those that meet criteria you 
set. Tagging marks the spreadsheet rows that meet your search criteria with an icon to the left 
of each row. 
 
Object: In CaseMap, "object" refers to the people, organizations, documents, and other things 
in your case. When you read "object," think "cast of characters". 
 
Short Name: Short Names are special names that you (or CaseMap) assign to each object and 
issue in your case. Short Names help you make links between various types of case 
information. 
 
 
 
 



5 

 

 Copyright © 2010 LexisNexis CaseMap®  

                           

 
 
 
 
 
 

The Workflow in CaseMap  

1. Use the Objects spreadsheets to create and organize the cast of characters.  The 
characters are the people, documents, organizations, and other things that are important to 
know about in the case. 

 
2. Use the Issues spreadsheet to organize and explore an outline of claims and arguments. 

 

3. Use the Facts spreadsheet to lay out the chronology of case facts. 
 

Starting a New Case 

Click  on the Getting Started with CaseMap panel.   Then let the 
wizard be your guide! 
 
CaseMap automatically generates a set of default fields for each spreadsheet when you create 
a new case file. You don't have to use all of these columns, but they’re available for use if 
needed. The default fields CaseMap sets up automatically should handle most of your data 
entry needs.  It's possible to create custom fields as needed. 
 
CaseMap makes it easy to get started building your cast of characters and entering information 
in a new case by displaying the Case Jumpstart Wizard when you complete the New Case 
Wizard.  Different types of people who are involved in the case have their own pages of the 
wizard, as do organizations.  Click the categories on the left or use the Next and Back buttons 
on the bottom of the wizard to page through the categories. 
 
Finish the wizard and CaseMap will automatically place the information you've entered on the 
appropriate spreadsheet of the new case file.  Then add details for the people, documents, 
organizations, etc. using the individual object type spreadsheets. HINT:  You can display 
shortcuts to all the spreadsheets in your  
 

CaseMap file by clicking on the Navigation Pane.  You can  view our 
recommendations for "best practices" on the work flow used to organize a case in CaseMap on 
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the interactive 3-step New Case Tips box at any time by opening it from the Help menu.  Move 
your mouse over the numbered steps on the left-hand side of the box and the tips on the right 

change.  Click the hyperlink under the Step 3 button to print the tips.  
 
 

 

Five Tips for CaseMap Success            

 
1) Right-click--a lot. The two most important locations that you can right-click within CaseMap 

are column (field) headers and within cells. 
 

2) Field header hints will give you quick info on what to do in a field.  Floating your cursor over a 
header (title) shows the hint. 

 
3) Use Short Names. Short Names are special, unique identifiers that are assigned to each 
person, place, or thing in your case. Don't worry about creating short names, CaseMap will do it 
for you. 
 
4) Start at the beginning. The best way to get the most out of CaseMap is to put it to use during 
the first days of a case. Make the most of CaseMap by putting it to work from the first 
conversation with a prospective client. Long before the first box of case documents arrives, use 
CaseMap to organize early case knowledge and to plan discovery. 

 
5) Phone home. If you have any questions contact our Support Team: 
 

877-301-0344  
 

You can also email Support at casemap.support@lexisnexis.com. We are available Monday - 
Friday 9:00 am - 6:00 pm ET. 
 
 
 
 
 
 
 
 
 
 

mailto:casemap.support@lexisnexis.com
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Short Names explained 

We highly recommend Short Name data entry. That said, you can enter data in CaseMap 
without using Short Names.  But if you do you'll lose much of the power that CaseMap puts at 
your fingertips to automatically connect case knowledge elements. 

 
Here are two important benefits of using Short Names: 
Using Short Names brings consistency to your case information. Without Short Names, it’s easy 
to use multiple names for the same person, organization, or document.  
 
Suppose you’re working on a case involving a defendant named Ridge Medical Center. If you 
don’t use Short Names, it’s likely that this one entity will be entered as RMC, Ridge, Ridge 
Medical, and Ridge Medical Center. Having multiple names for one entity is problematic. Use 
Ridge Medical Center's Short Name and you'll be confident that when you filter the chronology 
down to all facts that mention the defendant you won't miss a single critical fact. 
 
Short Names make data entry faster. And using Short Names makes links automatically as you 
type. Short Names can be just a few keystrokes. Rather than typing Ridge Medical Center over 
and over, just type RMC (and CaseMap gladly substitutes the Full Name as soon as you leave 
the cell). 
 
As you type in any of CaseMap’s description fields, use Short Names when you refer to 
persons, organizations, documents, and other objects.  When you use Short Names CaseMap 
makes links as you type. It’s easy to tell which fields recognize Short Names; look for the gray 
chain link symbol in the field name. 
 
The Link Assistant is a tool that helps you select Short Names. Here’s how: 
CaseMap reads what you type into description fields. When it spots the beginning of an object 
Short Name, CaseMap displays the Link Assistant, and selects the Short Name with the spelling 
closest to what you’ve typed. Press ENTER to accept the selection. 
 
As you work in any description field, you can pop up the Link Assistant and use it to search for a 
particular Short Name. Press CTRL + SPACEBAR. 
You'll know that CaseMap has recognized and linked a Short Name because it's underlined the 
object full name with dashes to give you visual feedback as you work. Underlining of Full Names 
doesn't print in reports. Short Names appear when you click into a description cell to edit its 
contents. When you leave the cell, CaseMap substitutes object Full Names for Short Names. 
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Entering information in a spreadsheet 

You've created your new case file; now you're ready to enter the information about the case into 
spreadsheets to organize case knowledge.   To enter data type directly into records on the 
spreadsheets. 
 
To add a new record, find and press the Insert key on your keyboard, or click the New Record 
button on the tool bar.  A new row will appear on the spreadsheet. 
 
To edit an existing row, double click into the cell in the record you'd like to update. 
There's no Save button in CaseMap; the information you enter is saved automatically as you 
work. 
 
If you need to undo your last edit, press the ESC key on your keyboard before leaving the cell. 
 
Dates and times 

CaseMap’s date fields handle common date situations. You have the option of using "Fuzzy 
Dates" in date fields.  You may need to use a fuzzy date when you know what month and year a 
fact occurred on but not the day, or maybe you know just the year.  CaseMap accepts the date 
information that you have, replacing the missing part with "??". 
 
In CaseMap, 99 is a valid date entry--CaseMap will display the date as ??/??/1999 and 
automatically sorts to January 1, 1999.  Likewise, 8/99 is also a valid date--CaseMap 
automatically displays the date as 08/??/1999 and sorts the date as August 1, 1999. 
 
You can enter date ranges in CaseMap’s date fields.  Your ranged dates will sort based on the 
first date.  An example of a valid date range is: "7/1/08 to 7/4/08".  A hyphen ("-") works to 
define the range, too. 
 
The Date Stamper is available to assist with date and time entries.  Click the button in a cell in 
the Date & Time field to use the Date Stamper. 
 
You can also enter times in CaseMap’s date fields. You have the option to display the times in 
12-hour or 24-hour time. Along with the fuzzy dates, you can enter fuzzy times such as 4:??.  
Your date ranges can also include times. 
To choose how your dates display, e.g., whether the day of the week displays, 24-hour time or 
to change MM/DD/YYYY order, select Options on the Tools menu, and go to the Date tab. 
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Changing the spreadsheet view 

You can change how the data is displayed on your screen, which is very important for two 
reasons.  One, it helps you organize your thinking while you are viewing the data on screen.  
Second, since reports are what-you-see-is-what-you-get, modifying the spreadsheet controls 
the appearance of reports. 
 

 
 
To hide a field:  click its field header (title) and select Hide Field on the menu. When you hide a 
field, you're not losing any of the data, you're just temporarily removing it from view. 
 
To insert a field or fields: Right-click any field header and select Insert Field(s) on the menu. A 
list of available fields will be displayed.  Then check the box(es) next to the fields you want to 
add to your spreadsheet and click OK. 
 
To move a field to a new position: Left-click on the field header, hold your mouse button down 
and drag it.  Release your mouse button to drop the field in a new place. 
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Working with the Objects spreadsheets 

CaseMap's Objects spreadsheets are where you organize lists of the persons, organizations, 
documents, and other things your case is about. Use Objects spreadsheets to produce 
Document Indexes, Exhibit Lists, Witness Lists, and Cast of Characters reports. 
 
Use the Navigation Pane sidebar to determine which Object spreadsheets you view. Favorite 
Shortcuts include: 
 

 
 
Display all the Object spreadsheets shortcuts by clicking the All Shortcuts bar. 
When your view is set to All Objects, the spreadsheet displays a mixture of persons, 
organizations, documents and other objects.  The fields in All Objects are common to all object 
types. 
 
When your view is set to a specific type of object, like Documents, the spreadsheet displays 
only items/objects of that specific type and it will include fields that are specific to that object 
type. For example, when your view is set to Documents, the spreadsheet will include the 
default fields CaseMap creates for documents, e.g., Bates-Begin, Bates-End and others. 
 
Working with the Facts Spreadsheet 

The easiest way to add facts to the Facts spreadsheet is to cull them from documents.  Over 35 
litigation support programs have integrated with CaseMap, incorporating a "Send to CaseMap" 
feature. 

 
Portable Document Format (PDF) is the most common format for electronic documents is.  
CaseMap's DocPreviewer plug-in for PDFs enables setting up documents as objects and culling 
linked facts from them. 
 
Try it!  Open the Hawkins v. Anstar Example case in CaseMap. Open a PDF using Adobe® 

Reader or Acrobat, click on the Select Text Tool button:   
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Click and drag across a bit of text.  Then use the  menu to send a new 

fact to CaseMap  . 
 

You'll be able to link the document into CaseMap as an Object, then use the selected text--plus 
your digestion, annotation, and other info re the fact--to the Hawkins case Facts spreadsheet as 
a new fact. 
 
You can use DocPreviewer's Send to CaseMap feature while in Review Mode looking at 
documents that have already been linked into CaseMap. 
 
Try it!  Still working in the Hawkins case, launch Review Mode from CaseMap's navigation bar 
by first opening the DocPreviewer panel using this button at the bottom of the navigation bar:   

 
 
Then click Review PDFs in the panel.  Acrobat or Adobe® Reader will open and the 
DocPreviewer PDF Review Wizard will open to guide you through reviewing PDFs that have 
been linked into CaseMap.  You can use the Send to CaseMap feature to add facts to the 
chronology as you review the documents. 
 
Another way to add facts to the Facts spreadsheet is by clicking the New Record/Fact (New 
Record.gif) at the upper-left corner of the screen.  Or you can use the keyboard shortcut Insert 
to add new facts.  Then type the fact info in the blank record that appears at the bottom of the 
chronology. 
All new facts are added at the bottom of the spreadsheet.  To re-sort the facts to chronological 
order click Refresh Table on the Records menu or use the keyboard shortcut F5. 
 
Linking 

CaseMap makes it easy to establish relationships among the different types of information you 
capture in a case file. For example, you can link a fact to the persons and organizations the fact 
is about, to the documents or depositions from which it is sourced, and to the issues that relate 
to it. 
 
Once you make links, you can use them to explore and analyze your case. For example, as you 
view the Issue spreadsheet, you can display a list of the facts linked to any issue with just two 
mouse clicks on the # Facts field. 
 
CaseMap makes linking as easy as possible. Most linking is accomplished for you automatically 
as you enter case data. 
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Internal and External Linking Methods 
 
Short Name Linking 
 
The most common way of internally linking things up in CaseMap is through Short Name data 
entry.  Any field that has a  in its title recognizes Short Names. You'll benefit greatly by using 
Short Names to refer to Objects in description fields like . 

 
Make automatic links in CaseMap by typing the first 3 letters of a short name.  For example if 
you want to type a fact about Philip Hawkins in the Hawkins example case type "haw" in a  
a Fact Text cell.  Then you'll see the Short Name Link Assistant appear.  

 

 
 

Press Enter and keep going.  The underline under a short name is a 
visual cue that CaseMap recognizes the short name and will make automatic links.  The 
underlines do not print in reports. You'll get consistent Full Name references throughout the 
case file, too: 
 

  
 
The next most common linking task is linking case issues to facts, people, documents, 
questions and research using the Issue Linking Tool.  You’ll learn more about that in Lesson 2:  
Analyze. 
 
 
 
 
Linking Facts to Source Documents 
 
One of the main reasons using CaseMap is so productive is that you can link relevant 
documents to the document index and fact chronology you construct using a "Send to 
CaseMap" feature--a part of CaseMap's DocPreviewer tool kit.  The Send to CaseMap dialog 
boxes look the same in 35+ litigation support programs, like Adobe®  Acrobat, Reader, 
LexisNexis TextMap®  and LexisNexis Concordance®.  CaseMap automatically puts 
DocPreviewer Send to CaseMap toolbar buttons in Acrobat and Reader during installation of 
CaseMap. 
 
If you want to link a PDF into CaseMap, open the document then click the Send PDF To 

CaseMap button on the toolbar:  
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You only have to link a document once into the CaseMap case file.  Then you’re ready to extract 
facts for the chronology. 
 
Here's how to send a fact to CaseMap's Facts spreadsheet from a PDF document that’s already 
been sent to (linked into) CaseMap : 
 

• Open the document and start reading. 
• When you spot an important passage that you want to use as the basis for a fact 

in the chronology, select it and click the Send to CaseMap button on Acrobat’s 

toolbar.  
• A new fact containing the text selection is created in CaseMap and linked back to 

the specific section or page of the document. 
 

The Issues Spreadsheet 

Use the Issues spreadsheet is to develop a hierarchy of case issues. Your issue outline can 
have as many levels or sub-issues as you want.  We recommend starting simple, with one or 
two levels, then building the outline as your investigation of the case proceeds. 
 
To create the outline, simply insert new rows directly where desired in the outline structure.  
Click and select the row you want your new issue to follow.  Click New on the toolbar or press 
the Insert key on your keyboard.  Type the Full Name of the issue. 
 

Click the arrows on thecompass icon   to demote, promote and move issues up or down. 
 
The # fields populate with numbers automatically when you use CaseMap's Issue Linker to link 
issues to Facts, Persons, Documents, and other case knowledge elements like Questions and 
Research.  You’ll find a button for the Issue Linking tool on the end of every spreadsheet toolbar 
in CaseMap (except Issues).  
 
Once you've made issue links you can double-click a number in a # field to display, review and 
print or PDF a list of records linked to a selected issue. 
 
Congratulations! 
 
Organizing case information takes time and effort but pays handsome dividends! You’ll reap 
those rewards when you analyze case information, develop case strategy and communicate 
knowledge organized in CaseMap to others in your organization or to the client. 
 
Take heart!  Lessons Two and Three are much shorter than Lesson One! 
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Lesson Two:  Analyze 
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Introduction 

Analyzing case data tells you what you know and can point the way to important information 
that you need to know.  Looking at the case info from various angles may offer insights not 
otherwise available.  Take this lesson and you'll have the tools you need to sort a 
spreadsheet, to search for data of interest (searching is also called filtering), to make issue 
links, and to explore the # fields to see the relationships among persons, facts, documents, 
and other case knowledge. 

 
Searching case data and viewing links can stimulate your thinking and can reveal patterns 
that may be useful in achieving the best results for your clients. 
 
Sorting a Spreadsheet 
 
Sorting determines how the rows in a spreadsheet are visually displayed. For example, 
when you create a new case the Facts spreadsheet defaults to a Date & Time sort with facts 
listed in chronological order.  You can sort any field in CaseMap spreadsheets except ones 
that recognized short names.  Fields that recognize short names have a  in the field 
header (title). 
 
To sort the fields in your spreadsheet click the field header, then select Sort Ascending or 
Sort Descending on the menu. Again, please note that some fields in CaseMap, like the 
10,000-character description fields (with a  in the header), cannot be sorted. 
 
If necessary, you can use multiple fields to sort your spreadsheet view. For example, you 
can sort the Questions spreadsheet first by the persons to whom questions are assigned 
and then by the date an answer is due. You must use the Advanced Sort dialog box to 
create a multi-column sort. Open it by selecting Advanced Sort on the Records menu. 
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Searching/Filtering a Spreadsheet  
 

In CaseMap, "search" and "filter" mean the same thing.  Filtering allows you to choose which 
records are in view on a spreadsheet. For example, you can filter the Facts spreadsheet so 
only undisputed facts display. You can use the Instant Search feature to run most filters. Or 

use Guided Search by clicking Search   on the toolbar.  We've put together a 
number of useful searches for every spreadsheet on the drop-down menu and on the My 
Saved Searches fly-out menu. 

 
When you execute a search a Search Results bar appears above the spreadsheet info.  
The bar tells you what filter(s) you have in place and gives you buttons on the right end of 

the bar to Cancel Search  or to Save the search.  Clicking  
opens a dialog for naming the search.  After naming it and clicking OK the saved search will 
be accessible on the Search toolbar drop-down in My Saved Searches. 
 
Instant Search 

 
1)  Right-click spreadsheet cells to run Instant Searches. 
2)  Right-click on the cell that contains the text you want to filter - a shortcut menu displays. 
3)  Use the Selection box to specify the word or words you want to filter/search for. 
4)  Click Filter by Selection. Your spreadsheet is now reduced to only those records that 
contain the text you have chosen. CaseMap generates reports that mirror what is in view.  
Your reports will only show the filtered data. 

 
You can add additional criteria to your filter/search to refine the records in view even further 
by repeating steps 1-4. When you run another filter on a spreadsheet that's already filtered 
you'll see the Combining Two Searches dialog.  It gives you options for adding the new 
criterion to your existing one(s). 

 
Cancel the search by clicking the Cancel Search button on the Filter bar above the 
spreadsheet. 

 
Guided Search 

 

Use guided search by clicking   on the toolbar. The searches you find on the 
menu are similar for each spreadsheet. For example, on the Search menu for Facts you can 
search for facts linked to people or documents, linked to issues, containing text, or added in 
the last day, week, month, or quarter.   
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My Saved Searches will give you spreadsheet-specific searches that are relevant to facts, 
like Disputed Facts and Undisputed Facts.  Any searches that you do and save are added to 
My Saved Searches. 

 
Running a saved search will cancel any filters that are in place before executing the saved 
search. Cancel any search by clicking the Cancel Search button on the Filter bar. 
 

 
Issue Linking 
 

The Issue Linking Tool 

It's useful to extract lists of facts linked to various issues in the case.  The same is true for 
documents that have been laboriously issue-coded.  The easy way to do issue linking on 
any spreadsheet in CaseMap (except the Issues spreadsheet where you define the issues) 
is by using the Issue Linking Tool. 
 

Find the Issue Linker on the right side of the toolbar  .  Click it and the Issue 
Linking Tool panel opens on the right side of the spreadsheet. 
 
Select the record in the spreadsheet where you want to start linking.  Click the issues on the 
Issue Linking tool that relate to the selected record.  You can link to multiple issues for one 
record.  When you want to move to the next record in the spreadsheet for thinking and 

linking click the  button.  Or back up with  
 

You can add a new issue using the Issue Linking tool.  Click the  button at 
the top of the panel.  Type the name of the new issue.  It will be added at the bottom of the 
outline.  If you want it in a different place in the outline go to the Issues spreadsheet.  You 

can move it up in the hierarchy using the compass symbol icon . 
 

 # Fields 

The columns with "#" in the title are keeping track of other case data associated with 
a record. # fields give you a count of the connections between case information, and 
they also make it easy to see the data behind the figures. 
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HINT:  Use Short Name data entry and CaseMap makes entries in many of the # 
fields automatically!  To see or print a list of the items you've linked that CaseMap 
has counted, just double-click the number in a cell or click the button in the cell. 

 
 

Compiling Research 

CaseMap has three research spreadsheets:  Authorities, Extracts from Authorities and a 
combo-Authorities and Extracts.  Start with the Authorities spreadsheet to list case law, 
statues, regulations, rulings, and articles that you want to reference.  Then extract passages 
that you want to track and copy them to the Extracts from Authorities spreadsheet. 
 
If you're using LexisNexis research content as part of your workflow solutions portfolio you 
can seamlessly import authorities from your Internet Explorer web browser using a Send to 
CaseMap feature. 
 
Send to CaseMap From LexisNexis Online Research 
 
Do you have a passage in a case you've found in lexis.com (www.lexis.com) or Total 
Litigator (www.totallitigator.com) that you want to add to your open CaseMap case file?  Just 
highlight it in your Internet Explorer browser, then right-click the selected area and choose 
Send to CaseMap. You'll see an Add New CaseMap Object dialog for the new Research 
Authority.   
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Click OK.  Then the Send to CaseMap - New Authority Extract dialog opens.   
 

 
 
Use the Favorite Fields area of the dialog to code additional information about the extract.  
Your selected text and other data will be added to the Research – Extracts from 
Authorities spreadsheet of your case file when you click OK. 

   

Please continue to Lesson Three – Report. 
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Lesson Three:  Report 

Table of Contents 

       Topic                Page 

1.  Introduction......................................................................................                21 

2. Spreadsheet = Report.......................................................................               21 

3. Reports Menu...................................................................................               22 

4. ReportBooks.....................................................................................               23 

5. Report Wizards.................................................................................               24 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



21 

 

 Copyright © 2010 LexisNexis CaseMap®  

                           

Introduction 

Create instant professional work product with a few mouse clicks and output to paper, PDFs, 
or Microsoft® Word. Your case analysis reports will become the raw materials that make it far 
easier to generate documents required by the court. For example, your Fact Chronology will 
make it far easier to create Motions for Summary Judgment and to produce the list of facts 
to which you're willing to stipulate needed for many pre-trial motions. 
 
CaseMap Reports use the What-You-See-is-What-You-Get principle, so what is displayed in 
your spreadsheet view is the same as what you see in your report.  Click the Print Preview 
button  on the tool bar to see a preview of your report,   CaseMap includes a title page  
when you print or preview your report.  You can customize the title page content and 
graphics by using the Page Setup dialog on the File menu. 
 
Spreadsheet = Report  
 
Here are three easy steps you can use to customize a spreadsheet: 
 

 
 

(Every field header has this menu.) 
 
 
1) To hide a field: Click its field header (title) and select Hide Field on the menu. When you 

hide a field, you're not losing any data; you're temporarily removing it from view. 
 

2) To insert a field or fields:  click any field header and select Insert Field(s) on the menu. 
You'll see a list of available fields.  Then check the boxes next to the fields you want to add 
to the spreadsheet view and click OK. 

 
3) To move a field to a new position: Left -click on the field header, hold your mouse button 
down and drag it.  Release your mouse button to drop the field in a new place when you see 
two arrows where you want the field to be. 
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The Reports Menu 

Use the Reports menu to print or PDF single-spreadsheet reports or ReportBooks.  A 
ReportBook is a compilation of saved case analysis reports (spreadsheets) that includes a 
title page, confidentiality statement, table of contents, introduction, and report title pages.  
Oh yes, the reports, too! 
 
CaseMap has a collection of report wizards available for making customized, highly-useful 
work product output a snap! 
 

 
 

Send the current spreadsheet view to: 
 

 Your printer 
 Print Preview 
 A PDF copy of the report that you can save or email 
 LexisNexis TimeMap* 
 LexisNexis NoteMap* 
 Microsoft® Word* or Corel® WordPerfect* 
 HTML 
 Microsoft® Excel* 

 

*You must have these programs installed in addition to CaseMap to produce the reports.  Word, 
WordPerfect, and HTML reports can be produced in Grid View (fields horizontal) or Record 
View (fields vertical). 
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ReportBooks 

 

The first two options on the menu are for working with ReportBooks.  You can modify the 
numbered, pre-built ReportBooks on the bottom of the menu or use them as they are with 
your case information.  You can create custom ReportBooks using the Manage 
ReportBooks option.  Or explore ReportBook Tools to create a report from a current 
spreadsheet view or to export or import a ReportBook definition to or from another case file. 
 
ReportBooks can be printed, previewed, PDFed and saved, or converted to PDF file 
attachments to an email. Each pre-built ReportBook's fly-out menu launches the Customize 
ReportBook dialog if you click Customize... Use the Customize dialog to add or drop 
spreadsheets, change Title Page and Introduction content or graphics and more. 
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Report Wizards 

Wizards make the production of sophisticated customized reports a simple step-by-step 
process. You will find the wizards described below on the bottom of the Reports Menu. 
 
The Privilege Log Wizard facilitates production of a report listing documents you've marked 
as privileged under attorney-client, attorney work product, or any privilege type you 
determine. 
 
The By Issue Report Wizard gives you comprehensive reports of all the records on any 
spreadsheet (except Issues) linked to a selected issue or set of issues.  Output the report to 
Word®, WordPerfect® or HTML. 
 
Produce By Object Reports with the By Object Report Wizard. For example:  facts grouped 
by document, facts grouped by person, documents grouped by person, and more! 
 
The Summary Judgment Wizard helps you prepare Motions for Summary Judgment, 
Statements of Disputed Material Facts, and Memoranda In Opposition court filings. 
 
 

Congratulations on completing the Quick Start Tutorial! 

We hope you enjoy using CaseMap.  Please get in touch if you have questions, comments 
or suggestions.  Call 877-301-0344 or email casemap.support@lexisnexis.com.  Hours for 
live support are 9:00 AM to 6:00 PM, Eastern U.S. time, Monday-Friday. 

 

mailto:casemap.support@lexisnexis.com
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